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Overview
The Internet utilizes Internet Protocol (IP) addresses for communication.    An IP address is the address of
a Transmission Control Protocol/Internet Protocol (TCP/IP) stack; therefore, every machine with TCP/IP 
has an IP address.    So, if you run Windows and you connect to the internet, your computer has an IP 
address of its own.    Here is a helpful analogy: Think of each machine with a TCP/IP stack as a house, 
and the IP address of the machine as the telephone number for that house.    If you know the phone 
number of your neighbor's house, you can pick up the telephone and place a call to him or her.    Similarly,
if a computer knows the IP address of another computer, it can attempt to establish communication with 
that computer.    Many other things have to fall into place for communication to be successful, but having 
the correct IP address is a rock-bottom starting point.    

Dial-Up Networking (DUN) is usually configured to allow your Internet Service Provider (ISP) to assign 
your machine an IP address each time you dial in and log on--the IP address is not necessarily the same 
each time, either.    An example of a typical IP address is 207.68.137.62 (which is www.microsoft.com).    

Domain Name Service (DNS) is a service your ISP provides to you.    A Uniform Resource Locator (URL) 
is the character string you enter into your web browser when you want to display the contents of a 
particular web site (for example, http://www.microsoft.com).    Like individual machines, each URL has an 
IP address assciated with it.    The DNS at your ISP has a huge table of URL names and the 
corresponding IP addresses.    Continuing with our house/telephone number analogy, you can think of a 
DNS as a telephone book.    If you wanted to call your neighbor, but didn't know the telephone number, 
you could consult your telephone book.    As you flipped through the telephone book, you would be looking
for a telephone number entry that corresponded to your neighbor's name.    In the same way, your web 
browser consults the DNS to find an IP address that corresponds to the URL you have entered.    Your 
web browser needs to do this because it cannot download anything from a web site until it knows the IP 
address associated with the URL you have entered.    This is simply because for your web browser to load
a particular web page, it must first establish communication with another machine—and determining the 
correct IP address is the very first step in this process.

In general, DNS's cannot hold every single URL/IP address combination that exists on the Internet at any 
given time—there are simply too many of them. There are, however, about 5 "master" DNS's in the world 
that do have the complete URL/IP list.    Every other DNS is linked to other DNS's throughout the world in 
a hierarchical manner.    Because of this, a standard DNS can query other DNS's for URL/IP addresses 
that are unknown to itself.    A DNS query can involve many requests around many DNS servers before 
reaching a "master" DNS machine for the ultimate verdict, and therein lies our loss of speed.

Using FastNet99, you can easily manage a local table of URL/IP addresses, and tell your system to check
that table first--before asking the DNS at your ISP.    The local table is stored on your system as a simple 
ASCII file, C:\WINDOWS\HOSTS    (C:\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS for Windows NT 
users). Note that the Hosts database is a rarity in that it does not have the usual three-character file name
extension.    The ability to use a local table for URL/IP address lookup is not a novelty added by 
FastNet99; rather, it is a native feature of Windows 9x/NT.    FastNet99 is a tool you can use to build and 
maintain—in other words, fully exploit—this native functionality.

When the local URL/IP table is used, no TCP/IP network traffic at all is generated to obtain IP addresses 
for known URL's.    And--since IP address lookups occur whenever you use a URL for finding an Internet 
resource--e-mail, FTP, gopher, and IRC functions can all benefit from the use of a local table.    Generally, 
the more URL/IP address entries you place in your Hosts file, the better.    The URL's whose IP lookups 



would take the longest time to resolve via standard DNS query are the ones that offer the most speedup 
when stored in a local table.



Add function
Overview

The purpose of this function is to resolve host names to IP addresses or IP addresses to names and to 
add them to the Hosts file. The IP configuration of your machine defines what DNS servers, if any, are to 
be used by the name resolution sub-system. 

 My IP address

This is the local IP address assigned dynamically by the server--or statically in the Windows configuration.

Clipboard usage

Double-clicking on My IP address or on the IP address displayed in the status bar after performing the 
add function will cause the corresponding IP address to be copied to the Windows clipboard.

This functionality is particularly useful to manage the common HTTP 404 error ("The requested item could
not be loaded by the proxy"). 

In this case there are two possibilities:

The URL requested doesn't exist, or;

The IP address corresponding to the URL requested is currently unavailable.

In the latter case, you can: 

Save the Hosts file, close your browser and then restart it again, or;

Simply double-click on the IP address displayed in the status bar and paste it into the browser address 
field.    In this way, the browser can attempt to go directly to the requested site.

Argomenti Relativi:
Find IP
Find URL



Find IP 

There are 2 different ways to use this function:

Data entry with one single field (default)

Please follow the steps below:

Select the Add tab in FastNet99.

Type the URL or IP address into the Enter server addresses text box in the FastNet99 window. 

Press <Ctrl-Enter> if you want to add more than one entry.    After doing so, the text box will be cleared, 
and you may enter another URL or IP address.    You may use the arrow keys or scroll bar buttons to 
move up or down to view all of your entries.

When you have entered all the URL's and/or IP addresses you wish to add, press the OK    button to start 
the search.

Note: If the URL('s) or IP address(es) you are trying to add is already known, you are alerted, and you 
can optionally verify them.

Data entry with three fields

Instead of having to add the entire URL into one field, you can use 3 fields: the first one containing the 
root name (ie. "www"), the second one containing the server name (ie. "microsoft"), and the third one 
containing the domain root (ie. "com").    This would speed the adding of URLs greatly, as often times, only
the second field would need to be added.

The 2 combo box can store 10 items: then, the first one will be deleted and the new one will be added.



To enable this functionality check the option "Data entry with 3 fields", in the Options tab.

Batch Domain Processing

Checking this option the program would search for any possible variation of the domain.

For example, let's suppose that the combo box Root contains the words "www" and "ftp" and the combo 
box Domain contains "com", "net" and "org". Type "netscape" in the second field and click on the OK 
button.    The program will search for "www.netscape.com" , "www.netscape.net" , "www.netscape.org" , 
"ftp.netscape.com" , "ftp.netscape.net" , "ftp.netscape.net".

URL Parsing

If you type the entire URL for a page you are setting up, or paste a URL you copied from your web 
browser, FastNet99 will grab only the information from the URL that it needs to set up the Hosts file.    For 
example, if you type in http://www.MySite.com/dirname/filename.html, when you press the OK button, 
FastNet99 will transform it into http://www.MySite.com and will find the corresponding IP address.



Find URL 
The purpose of this function is to find URLs for a range of IP addresses. 

The textboxes allow the user to enter beginning and ending IP addresses.    When the OK button is 
pressed, the program will attempt to resolve each of the IP addresses in the range (inclusively) starting at 
the "Starting IP Address" and ending at the "Ending IP Address".    The Status Bar will tell you which IP 
address the program is currently trying to resolve.    

Argomenti Relativi:
Input box
OK button



Input box
This is the text box where you can enter the URL or the IP address you want to add to the Hosts file.



OK button
Once you have entered a URL or IP address in the text box, click this button to find the corresponding IP address or URL.    

Then, FastNet99 will perform the appropriate search and add the entry to the Hosts database.



Edit function
Overview

On this tab, you can view and manage your Hosts database. 

The available functions are as follows:

Rename servers

Renaming servers you can use keywords to quickly jump to sites during navigation. For example, 
renaming "http://www.microsoft.com" to "ms" in the Hosts file, you can type ms and browser will expand it 
to http://www.microsoft.com. 

Delete

Deletes the selected servers from the Hosts database.

To remove existing unwanted entries select them and press the Delete button.    To select multiple entries,
hold down the <Ctrl> key as you select each one.    To select a range of adjacent entries, hold down the 
<Shift> key as you select the last entry to be deleted.

If you make a mistake, simply exit FastNet99 without saving your changes.    Because of the possibility of
error, it is recommended that you save your Hosts database before performing the delete function.

Verify selected URLs

Checks and (if necessary) updates the IP addresses of the selected URL('s) in the Hosts database.

To check and correct existing entries, simply select the ones you wish to verify, then press the Verify 
button.    The entries will be updated with the new IP address, if necessary.    To select multiple entries, 



hold down the <Ctrl> key as you select each one.    To select a range of adjacent entries, hold down the 
<Shift> key as you select the last entry to be verified.

Verify all URLs

Checks all IP addresses in the Hosts database and updates those that have changed.    If your Hosts file 
contains a large number of entries, this function may take quite a long time.    In this case, you may want 
to select Find addresses in background mode on the Options tab.

Duplicates

Even if FastNet99 doesn't allow to insert    duplicate entries in the hosts file, you can get this by    
renaming URLs or manually editing the Hosts file.

You can remove these duplicates by pressing the Duplicates button or by choosing Duplicates    from 
the context menu.

IE cache

Explores the Internet Explorer local cache for checking whether selected URLs are in cache.

Edit as text

Starts your preferred editor and loads the Hosts file.    This is useful if you want to manually edit the Hosts 
file, or if you want to print it.

If applicable, FastNet99 will prompt you to save your changes before editing to reload the file when 
returning.

Browse

Double clicking on an item starts the default browser and goes to the selected site.

Fast Search

The "Fast Search" combo box is useful to quickly find server names in the list view.

It stores until 10 servers typed in: then, the first one will be deleted and the new one will be added.

To clear on exit the typed URLs history select the option "Clear Fast URLs history on exit".

Context menu

Clicking on the servers list with the right mouse button a context menu appears with the available 
functions and the "Fast URLs Search" typed URLs.



Options
Overview

The contents of this tab allow you to configure FastNet99 according to your preferences. 

Your preferences can be saved    by pressing the Apply button.

The Default button restores default settings (included size and position)

Argomenti Relativi:
General
Add
Edit
Batch
Ping



General
Always visible

With this option, FastNet99 stays on top of all other windows.

Finding addresses in background mode

FastNet99 can hang out in the system tray while finding IP addresses.    A single click on the FastNet99 
icon will resize the main screen, which can then be easily dropped back down to the system tray until 
needed again.    A right click on the icon will give you a menu for opening the FastNet99 window and for 
performing Save, Report, Help, About and Exit functions. 

Add shortcut to the desktop

Creates a FastNet99 shortcut on the Desktop. It can be very helpful when you want quick access to the 
program.

Start automatically with Windows

Creates a FastNet99 shortcut in the Startup folder.

Start minimized

Causes FastNet99 to start in minimized mode.    This option is useful if you have also selected Start 
automatically with Windows.

Stop on error

This option causes DNS lookups to be interrupted if a corresponding IP addresses cannot be found.

Save size and position

Saves on exit the size and the position of the main window.

Show splash screen at startup

You can choose to hide the logo appearing on startup.



Add 
Data entry with 3 fields

Changes the    data entry    of the Add function from one to three entry fields. 

Instead of having to add the entire URL into one field, you can use three fields: the first one containing the
root name (ie. "www"), the second one containing the server name (ie. "microsoft"), and the third one 
containing the domain root (ie. "com").    This would speed up the adding of URLs greatly, as often times, 
only the second field would need to be added.

The 2 combo box can store 10 items: then, the first one will be deleted and the new one will be added.

Clear Root and Domain on exit

Clears the "Root" and "Domain" URLs history on exit.



Edit
Editor

Sets your preferred editor in order to edit the Hosts file

Fonts

Fonts function in order to choose fonts and colors of the URLs listview

Clear Fast URLs history on exit

Clears the "Fast URLs Search" typed URLs history on exit



Batch
Monthly batch functions

These options allow you to schedule selected functions to run at the start of each month.



Ping
Number of pings

Number of echo requests to send.

Interval(msec)

Time interval in milliseconds between requests.

Timeout(msec)

Timeout in milliseconds. 

Size(bytes)

Packet size (default is 64 bytes).



Bookmarks function
Overview

Adds your bookmarked URL's to the Hosts database.

You can use the Search the Registry button to automatically configure the paths to your bookmark 
files/folders.    Or…

If you use Internet Explorer, type the path of the Internet Explorer favorites folder in the 
corresponding text box (e.g. C:\Windows\Favorites).

If you use Netscape Navigator, type the path of    the Netscape Bookmark.htm file in the 
corresponding text box (e.g. c:\Program Files\Netscape\Users\Bookmark.htm).

If you use Opera type the path of    the Opera Hot List file in the corresponding text box (e.g. c:\
Program Files\Opera\Opera3.adr).

Connect to the Internet, and press the Scan button to begin scanning your bookmarks.

Powermarks users (By Scott Danesi)

If you use Kaylon Powermarks (http://www.kaylon.com/, or 207.137.212.11) instead of Netscape 
Bookmarks, Internet Explorer Favorites, or Opera Hot Lists, you can still build a Hosts database.    
However, since FastNet99 cannot read the Powermarks file directly, you will need to first export your 
Powermarks file to Netscape Bookmark format, which FastNet99 can read.    This file export is done from 
within Powermarks.    (To learn how to export a Powermarks file, please consult the Powermarks help file. 
Don't worry, it's very straightforward.    Hint: The export function is accessed via the File menu.)    



Note: The Netscape Bookmark-type file you create does not have to be named Bookmark.htm, but, if it is 
not, you will have to manually enter its path and file name in FastNet99 in a later step.

After you have exported your Powermarks list, launch FastNet99 and go to the Bookmarks tab.    Then, in 
the text box labeled "Enter the path of the Bookmark.htm file," manually enter—or navigate to—the path 
and file name corresponding to the Netscape Bookmark-type file you just created.    Remember, if the file 
you just created is not named Bookmark.htm, you will need to manually enter the path and file name in 
FastNet99.

That's it.    FastNet99 is ready to scan your exported Powermarks file.    Connect to the Internet, and click 
Scan to begin.

If you use Netscape Navigator, you may automatically reset the path to the Netscape Bookmark file by 
clicking the button labeled Search the Registry.



History function
Overview

Adds your visited URL's to the Hosts database.

You can use the Search the Registry button to automatically configure the paths to your history 
files/folders.    Or…

If you use Internet Explorer, type the path of    the Internet Explorer history folder in the 
corresponding text box (e.g. c:\Windows\History).

If you use Netscape Navigator, type the path of    the Netscape fat.db file in the corresponding text 
box (e.g. c:\Program Files\Netscape\Users\<user name>\Cache\Fat.db).

If you use Opera, type the path of    the Opera Hot List file in the corresponding text box (e.g. c:\
Program Files\Opera\Global.dat).

Make sure you are connected to the Internet, then press the Scan button to begin the scan of your history
file/folders.    FastNet99 will read your browser history for visited URL's and then, for any corresponding to
unknown IP addresses, will query a DNS to obtain the correct IP address.



File menu functions
Save 

Saves to disk all changes made in the Hosts file, and creates a backup copy of the previous Hosts file 
with a BAK extension. If you quit the program without saving changes, a message box    will appear 
asking you if you would like to save your changes.

Save As 

Clicking with the right button of the mouse on the Save button you can save the changes made to the 
Hosts file to a backup copy file (the default name is Hosts.sav).

Abort 

Aborts the active function.

Update 

Checks whether a newer version is available on the Web.

Suggested usage is to periodically launch this function to perform a version check by setting the Update 
option (see Options-- monthly batch functions). If a different version is found the one used, you are 
alerted and browser starts for downloading the upgrade. This allows the flexiblity to prompt the user to 
download a newer version if one is available. 

Report 

Displays several separate lists, which represent operations done in    the current session.

Exit 

Exits FastNet99.



Preferences
Ignore list

The purpose of this function is to manage an URLs list of sites that FastNet99 does'n have to add to the 
Hosts file. In fact, some sites change dynamically their ip address. So, it's advisable do not insert these 
URLs in the Hosts file.

Here is a list of servers not recommended to be added:

icq.mirabilis.com

ftp.hypermart.net

http://www.yahoo.com

 http://www.microsoft.com

http://www.nasa.gov

For these sites will then be used your ISP's DNS table to find the servers IP address.

Import configuration

Updates your configuration file FastNet99.ini from a previously saved configuration file.

Export configuration

Saves your configuration copying the configuration file FastNet99.ini to a SAV file. It's useful for making a 
backup copy of the configuration.



Tools
Ping

Ping is short for "Packet Internet Groper".

The purpose of this tool is to time and analyze the response of a given IP network host or device. Using 
the ICMP protocol, a number of ECHO REQUESTS are sent. After each request, an entry is added to the 
Results list. Entries may include response times or error messages depending on the host response. 
Timeouts result in a "Request timed out" message.

The Ping Dialog provides summary information including the following:

Total number of packets sent

Total number of packets received

Total number of packets lost

Maximum response time

Minimum response time

Average response time



Help
Contents 

Launches this help file.

For contextual help, set focus on required object and press <F1>.

See also the Readme.txt located in the FastNet99 directory.

About button

Shows a screen with Copyright details and some other informations about the program. 



Overview
This program merges the entries of two different Hosts files into a single Hosts file.    For example, you 
can add the entries in the Hosts file that comes with FastNet99 to your own Hosts file. 

Type in the input and the output Hosts files in the corresponding text boxes, and then press the <OK> 
button. 

FastNet99 will automatically show the following screen:

In this screen you can:

Select from the input listbox your preferred servers and copy them to the output listbox pressing the Copy 
button.

Copy all servers from the input to the output listbox pressing the Copy all button.

Press the Save button to save modifications, finally press the Cancel button to close the window.

Argomenti Relativi:
Input Hosts file textbox
Output Hosts file textbox
OK command button



Input Hosts file listbox
Output Hosts file listbox
Copy button
Copy all button



Input Hosts file textbox
This is the text field where you can enter the path of the input Hosts file you want to merge to the output Hosts file. For example, 

you can enter the path of the FastNet99 Hosts file (located in the FatsNet99 directory).



Output Hosts file textbox
This is the text field where you can enter the path of the output Hosts file you want to merge from the input Hosts file. Typically, you

would enter the path of the active Hosts file (located in the Windows directory for Windows 9x users, and in WinNT\system32\

drivers\etc for WinNT users).



OK command button
This button is used to load the input and output Hosts files into memory. Then the Copy screen will appear.



Input Hosts file listbox
This listbox contains the entries of the input Hosts file.    You can select the entries you want to add to the output Hosts file and 

press the Copy button or you can press the Copy All button to copy all itmes from the input Hosts file to the output Hosts file.



Output Hosts file listbox
This listbox contains the entries of the output Hosts file.



Copy button
This button is used to copy the selected entries from the input Hosts file to the output Hosts file. 



Copy all button
This button is used to copy all entries from the input Hosts file to the output Hosts file. 



Overview
Q1. The installation process tells me "failed to register C:\windows\system\web VChk6.ocx" or something 
like that. It also tells me this "did not find file MSVBVM60.dll".

A1. You need the VB 6.0 run time files.    You can download them at either of the following addresses:

ftp://ftp.microsoft.com/Softlib/MSLFILES/VBRUN60.EXE

http://support.microsoft.com/download/support/mslfiles/Vbrun60.exe

ftp://ftp.simtel.net/pub/simtelnet/win95/dll/simvb6-2.zip

4. ftp://195.31.191.10/pub/pc/windows/win98/programming/vbasic/vbrun60.exe

To install it, simply run the exe file. After, reinstall FastNet99.

Q2. Do I need to have FastNet99 running for it to speed up my browsing? 

A2. You do not have to keep FastNet99 open for it to speed up your Internet activities.    We do 
recommend, however, that you have FastNet99 open to easily maintain the Hosts database as needed.

Q3. I    can't access a site that has been added to my Hosts file. What can I do? 

A3. Some sites like www.yahoo.com, www.microsoft.com, www.nasa.gov, and icq.mirabilis.com change 
dynamically their ip address. So, it's advisable do not insert these urls in the Hosts file. Moreover, 
sometimes some URLs could change their ip addresses. You could manually edit the Hosts file (located in
the Windows dir. for Win9x users and in WinNT\system32\drivers\etc for WinNT users) or use the Delete 
function of FastNet99 for removing these urls from the Hosts file. Alternatively, use the Verify function in 
order to keep up-to-date the file or remove it from the pc. See the Verify function for more informations on 
how to do this. 

Q4. I    can't access a site that has not been added to my Hosts file. What can I do?

A4. Launch FastNet99 and add the site.    Then save the Hosts file and restart your browser, or simply 
double-click on the IP address shown on the status bar and paste it into the browser address text box. 
See Add function for more information on how to do this. 



Newspaper article
On the Internet

FastNet99 gives you a free and foolproof way to speed up the Web

By Al Fasoldt

Staff Writer

Most ways of speeding up your Internet connection are tricky.    They might not work right or they could 
mess up your PC forever.

What if I told you I know a foolproof way to speed things up?    And I mean REALLY foolproof.

A way that works with any kind of connection--dialup, cable modem, direct T1 line, even AOL.    A way that
cannot possibly interfere with other programs.

Sound too good to be true?    That's what I thought, too.    But after many weeks of using FastNet99, a free
Windows program, I'm a believer.    FastNet99 even wins points in another area, too-- it's easy to use.

FastNet99 was written by Italian programmer Giuseppe Criaco, who describes himself as a believer in 
"freeware software."

You can learn more about FastNet99 at http://www.geocities.com/Times Square/Stadium/1851/.    (Don't 
write that down.    Go to my Web site and click on the link within the article.    The Web version of this 
article also has a link to the FastNet99 download file, which is too complicated to print in the newspaper.)

FastNet99 runs under Windows 95 and Windows 98.    What it does can be explained simply: FastNet99 
creates a list of Internet sites and matches them to their actual addresses.

Normally, your Web browser has to wait to get the real address before it can go to a site, and this can 
take a while.    If it already has the actual address, the browser can open Web pages very quickly.

If this seems mysterious, take a minute to read a more detailed explanation.    All sites on the Internet 
have addresses.    They're like street addresses, except that Internet addresses are always written as 
numbers.

These are called IP numbers.    (Think of them as Internet Postal numbers and you'd almost be right.    
They're Internet Protocol numbers.)    You can't get to a site on the Internet unless you have the right 
address, just like you can't send a package to Aunt Ethel unless you tell the parcel service where to take 
it.

So if all the sites have numbered addresses, how come all of us don't go around saying things like, "Hey, I
went to the 345889023 site last night!    What a blast!"    Or, "Wow, 88234003 has a lot of free downloads!" 
We don't do that because we use aliases for these numbers.    We use words instead, and the computer is
left with the task of translating those words into numbers, into their real addresses.

We use addresses like " microsoft.com" and "altavista.com"--what we call the names of domains --when 
we want to go to a Web site.    Somebody has to do a translation in a hurry, so your browser sends out an 
urgent message for a conversion.    Sites that do just that are all over the place, and they specialize in 
changing names of domains into numbered IP addresses.    (These sites are called Domain Name 
Servers.)

Make sense so far?    What I'm saying is that getting on to a Web site normally is a four-step process.    
Step 1: You tell your browser to go to http://www.abc.com, but it literally cannot do that.    Step 2: So it 



asks another site, called a DNS server, to translate the name http://www.abc.com into its IP number.    
Step 3: The DNS site sends the real address back to your computer.    Step 4: Your computer takes that 
address and sends it back out onto the Internet and waits for the Web site to respond.

Whew!    Anytime you can cut out two of those steps you're guaranteed to get things done faster.    And 
that's what FastNet99 does.    It looks at all your Favorites and Bookmarks and sends out DNS requests 
for all of them during a quiet time (while you're having dinner, maybe.)

It then stores the list of names and real addresses in a standard "hosts" file; (Windows knows how to use 
the "hosts" file already, so FastNet99 doesn't need to do any fancy footwork there.)    Then its work is 
done.

FastNet99 doesn't need to be running when your on the Web, so your PC isn't loaded down with yet 
another Internet utility.    I like that.

How much faster do pages come up from sites that are listed in the "hosts" file?    Twice as fast, maybe 
three times as fast.    Sites that aren't speeded up, of course, so the best way to use FastNet99 is to keep 
a LOT of Favorites or Bookmarks and have FastNet99 translate all of them once a week.    My list has 
1,400 names so far, and it's growing.    (There is a practical limit to the size of the "hosts" list, but you're 
not likely to hit it.)

Al Fasoldt, systems editor of The Syracuse Newspapers, writes this Internet column weekly for Stars.    
He can be reached by e-mail at mailto:features@syracuse.com or by regular mail c/o Stars, P.O. Box 
4915, Syracuse, NY    13221.

This article appeared in the February 7, 1999 Sunday Herald American in a section labeled Stars 
Magazine ….Page titled      COMPUTERS, and in the MSNBC site at the following address: 
http://www.msnbc.com/news/240148.as



Glossary of Terms
DNS
Gateway
Hosts
ICMP
IP address
IP datagram
Localhost
Packet
RTT
TCP/IP
URL



DNS
Short for Domain Name System (or Service), an Internet service that translates domain names into IP 
addresses. Because domain names are alphabetic, they're easier to remember. The Internet however, is 
really based on IP addresses. Every time you use a domain name, therefore, a DNS service must 
translate the name into the corresponding IP address.    For example, the domain name 
"www.example.com" might translate to 198.105.232.4. The DNS system is, in fact, its own network. If one 
DNS server doesn't know how to translate a particular domain name, it asks another one, and so on, until 
the correct IP address is returned.



Gateway
A special purpose, dedicated computer that attached to two or more networks and routes packets from 
one to the other. In particular, an IP gateway routes IP datagrams among the networks to which it 
connects. Gateways route packets to other gateways until they can be delivered to the final destination 
directly across one physical network. 



Hosts
The Hosts file is found in your Windows directory (e.g. C:\Windows\Hosts), for Windows 9x users, and in 
WinNT\system32\drivers\etc for Windows NT users.    This file holds information about internet sites and 
their corresponding IP addresses.    Adding a specific URL and IP address to the Hosts file will cause your
browser to bypass the DNS lookup step for that URL and go directly to the Internet site using the IP 
address.    If you have problems getting to certain sites due to DNS problems, using a local Hosts 
database can solve that problem by using your own settings for that site.



ICMP
This is an acronym for Internet Control Message Protocol.

An integral part of the Internet Protocol (IP) that handles error and control message. Specifically, 
gateways and Hosts use ICMP to send reports of problems about datagrams back to the original source 
that sent the datagram. ICMP also includes an echo request/reply used to test whether a destination is 
reachable and responding.



IP address
The 32-bit address assigned to hosts that want to participate in a TCP/IP Internet. IP addresses are the 
abstraction of physical hardware addresses just as an Internet is an abstraction of physical networks. 
Actually assigned to the interconnection of a host to a physical network, an IP address consists of a 
network portion and a host portion. The partition makes routing efficient.



IP datagram
The basic unit of information passed across a    TCP/IP Internet. An IP datagram is to an Internet as a 
hardware packet is to a physical network. It contains a source and destination address along with data.



Localhost
It's a special IP name that always refers to the local host and, by convention, has the IP address 
127.0.0.1.



Packet
The unit of data sent across a packet switching network.



RTT
This is an acronym for Round Trip Time.

A measure of delay between two hosts. The round trip time consists of the total time taken for a single 
packet or datagram to leave one machine, reach the other, and return.



TCP/IP
It means Transmission Control Protocol/Internet Protocol. 

This term refers to a transmission protocol very often used in the Unix operating system environment.    
TCP/IP was originally developed by Advanced Research Projects Agency (ARPA), a division of the United
States Department of Defense (DOD).    All computers connected to the Internet use this protocol.



URL
This is an acronym for Uniform Resource Locator.

This term indicates an Internet address expressed in a way understandable to any Web browser.    Web 
addresses usually start with http:// (or with another word followed by ://) and end with .html or with a 
simple final slash (/) to point to a predefined file in a folder.




